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Introduction

In a cooling system, a microelectronic component has been identified as the critical link. 
Since the power is repeatedly switched on and off, the component is subjected to thermal 
cycling. As a result, a crack grows through a solder joint and disconnects the chip from the 
printed circuit board, causing a malfunction. In the simulation, the solder lifetime in two 
ball grid assemblies is predicted. The prediction is based on the Darveaux energy-based 
model. The fatigue model evaluates damage based on an averaged energy dissipation 
density in a thin layer, where a crack is expected to grow.

This example is based on a model from the Nonlinear Structural Materials Module: 
Viscoplastic Creep in Solder Joints. Since the model contains several solder joints that are 
modeled with a viscoplastic material, many degrees of freedom are required in order to 
simulate the correct creep behavior in all elements. From the fatigue point of view, only 
the critical part of the model is of interest. In order to capture it, the concept of 
submodeling is used. This technique consists of two steps. In the first one, the full model 
is analyzed with a coarse mesh in order to capture the general trends and to identify the 
critical part of the model. In the second step a fine submodel containing the critical part 
is made and the study is resolved. The global effects from the full model are transferred to 
the submodel via appropriate boundary conditions.

Model Definition

The microelectronic component consists of a flat printed circuit board that is covered with 
a thin copper layer. Two microprocessors are connected to the copper layer with a ball grid 
array of 60Sn-40Pb solder joints; see Figure 1.

Both microprocessors generate power when they are switched on and when they are in 
stand-by. This generates heat throughout its operational lifetime. The power cycle is at its 
maximum, 5·107 W/m3, during 4 h and at its minimum 1·107 W/m3, during 2 h. The 
switch between high and low power is not instantaneous, but takes few minutes.
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Figure 1: Geometry of the microelectronic component.

The elastic and thermal properties of the material can be taken from the built-in material 
library in COMSOL Multiphysics. The heat transfer coefficient for all free surfaces can be 
approximated with 10 W/(m2·K). The nonlinear behavior of the solder material follows 
the Anand material model with parameters summarized in Table 1.

TABLE 1:  CONSTANTS OF THE ANAND MODEL.

PROPERTY VALUE DESCRIPTION

A 1.49·107 1/s Pre-exponential factor

Q 90,046 J/mol Activation energy/Boltzmann constant

 11 Stress multiplier

m 0.303 Strain rate sensitivity of stress

ssat 80.42 MPa Coefficient for deformation resistance saturation

sinit 56.33 MPa Initial value of deformation resistance

h0 2640.75 MPa Hardening coefficient

a 1.34 Strain rate sensitivity of hardening

n 0.0231 Sensitivity for deformation resistance
3 |  E N E R G Y - B A S E D  T H E R M A L  F A T I G U E  P R E D I C T I O N   I N  A  B A L L  G R I D  A R R A Y



The Darveaux fatigue model is representative for life prediction of the solder material. The 
model combines life contributions from crack initiation and crack propagation using the 
expression

where N is the fatigue life given in number of cycles, Wave is the averaged dissipated 
energy density in a fatigue cycle, a is the distance the crack needs to propagate for the 
failure to occur, and K1, k2, K3, k4, and Wref are material constants. The numerical values 
of the material constants are given in Table 2. 

The distance a is in this analysis be taken to be 2.6457·104 in. This is based on the 
assumption that the problem is not symmetric and a crack is expected to start on one side 
of the joint only and not all around the joint at the same time. 

The concept of submodeling is utilized in this example. This technique requires that first 
an analysis of the full model is performed in order to capture general trends, followed by 
an analysis of a submodel that is studied in detail. The following steps are done:

1 A coupled structural and thermal analysis is performed during four load cycles on the 
full model. Since the model contains several solder joints, a coarse mesh is used. All 
joints are meshed in the same way in order to minimize numerical discrepancies that are 
mesh dependent.

2 A fatigue prediction is made on the fourth cycle. The energy dissipation volume average 
and corresponding life is evaluated for each individual solder joint. The critical joint is 
identified.

3 A submodel of the critical joint with a fine mesh is created. The displacements from step 
1 are prescribed as Prescribed Displacement on the boundaries where the submodel is cut 
out of the full model. Similarly, the temperature from step 1 is prescribed as a 

TABLE 2:  FATIGUE MATERIAL PARAMETERS.

PROPERTY VALUE DESCRIPTION

K1 13,173 Crack initiation energy coefficient

k2 -1.45 Crack initiation energy exponent

K3 3.92·10-7 in Crack propagation energy coefficient

k4 1.12 Crack propagation energy exponent

Wref 1 psi3 Reference energy density

N K1
Wave
Wref
--------------- 
 

k2 a

K3
Wave
Wref
--------------- 
 

k4

---------------------------------+=
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Temperature in the heat transfer analysis of the submodel. This is done for all time steps 
of the four simulated cycles. 

4 A fatigue analysis is performed on the critical solder joint in the submodel. A life 
prediction is made based on the energy dissipation in a 50 m thick layer. Two layers 
are evaluated. One that is in connection with the copper side and one that is in 
connection with the microchip side. 

The submodel is shown in Figure 2. The purple color denotes the boundaries where the 
results from the structural analysis of the global model are prescribed. The solder joint is 
divided in three domains: a central one and two domains close to the interface to the other 
materials. 

Figure 2: Submodel containing the critical joint. 

Results and Discussion

The fatigue life prediction for all joints is shown in Figure 3. For both microchips, the 
critical joints are located in the corners of each ball grid array. This is expected, since those 
joints experience highest strains due to the differences in thermal properties. The solder 
joints of the microchip with the larger ball grid array shows a shorter life than the joints of 
the other microchip. The life prediction for all four corner joints is about the same, 
5.8·104 cycles.
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Figure 3: Fatigue life prediction for all joints based on the global model. 

One of the four critical corner joints is reanalyzed in the submodel. In order to verify that 
the temperature is correctly prescribed in the submodel a comparison of the temperature 
history in a point on the upper sider of the joint is shown in Figure 4. The results of both 
models are in prefect match. Note that much fewer data points are stored for the 
submodel.
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Figure 4: Temperature history for both the full model and the submodel.

A comparison of the dissipated energy in a point on the upper side of the joint is shown in 
Figure 5. The results differs between the two models. This difference is caused by the 
difference in the mesh. The finer mesh in the submodel is better than the coarser mesh of 
the full model in capturing the strain gradient close to the upper side of the solder joint. 
Note that much fewer data points are stored in the submodel for the first three cycles, 
hence, the presented results are not a smooth. This does not affect the accuracy of the 
solution.
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Figure 5: Comparison of the dissipated creep energy in both models.

The results of the fatigue analysis of the critical joint in the submodel are shown in Figure 6 
and Figure 7. In the first figure, the fatigue life is based on the energy dissipation volume 
average evaluated over the whole joint, while in the second figure the volume average is 
performed over separate domains. The fatigue life predicted by different models is 
summarized in Table 3.

The difference between the fatigue life prediction of the full model and of the submodel 
is small. It is however observed in real applications that a crack grows through a solder 
joint close to the interface and therefore a thin layer is required. If a thin layer were to be 
created in all joints of the full model, the simulation would require large computational 
resources. In the current example, the full model consists of about 170,000 DOFs while 
the submodel consists of 40,000 DOFs. 

TABLE 3:  FATIGUE LIFE BASED ON DIFFERENT MODELING TECHNIQUES.

EVALUATION METHOD FATIGUE LIFE (CYCLES) SOURCE

Entire joint in the full model 5.8·104 Figure 3

Entire joint in the submodel 8.1·104 Figure 6

Thin layer in the submodel 9·103 Figure 7
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Figure 6: Fatigue prediction based on the volume average of the entire joint.
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Figure 7: Fatigue prediction based on the volume average of different domains.

Notes About the COMSOL Implementation

In submodeling, the results are mapped from one component — a full model — to another 
one — a submodel. This is possible through the General Extrusion operator. In this 
example, the mapping of results is simple since it is 1 to 1. The General Extrusion operator 
allows also for mapping into other shapes. 

Often, a load history in a fatigue study is repeatable. In order to write the cyclic function 
in a compact way, a modulo function can be used. This function calculates the reminder 
of a number, dividend, divided by an other number, divisor. In COMSOL Multiphysics it 
is defined as mod(f,p), where the first argument is the dividend and the second one is the 
divisor.

From the numerical point of view, an abrupt change in a load parameter can be 
challenging. In the current example, a sudden increase or decrease of the power provides 
such a challenge. In such a case it is favorable to use a smooth function that changes from 
one value to an other. This is possible in via flc2hs(t,p) function that is a Heaviside 
function with a smooth second derivative. The first argument defines a position when the 
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step takes place and the second argument defines an interval on each side of the step 
position where the smooth transition takes place. 

Application Library path: Fatigue_Module/Energy_Based/
viscoplastic_solder_joints_fatigue

Modeling Instructions

In this example you will start from an existing model which is an example in the Nonlinear 
Structural Materials Module.

A P P L I C A T I O N  L I B R A R I E S

1 From the File menu, choose Application Libraries.

2 In the Application Libraries window, select Nonlinear Structural Materials Module>

Viscoplasticity>viscoplastic_solder_joints in the tree.

3 Click Open.

F U L L  M O D E L

1 In the Model Builder window, click Component 1 (comp1).

2 In the Settings window for Component, type Full Model in the Label text field.

Define the crack size that will be used in crack models.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Define the power load cycle.

Analytic 1 (power)
1 In the Model Builder window, click Analytic 1 (power).

Name Expression Value Description

lcrack 2.6457e-4[in] 6.7201E-6 m Crack size
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2 In the Settings window for Analytic, locate the Definition section.

3 In the Expression text field, type (flc2hs(x-0.1,0.1)*50)*(x<6)-flc2hs(mod(x,
6)-4.1,0.1)*40+(flc2hs(mod(x,6)-0.1,0.1)*40+10)*(x>=6).

F U L L  M O D E L  ( C O M P 1 )

Create a General Extrusion operator that will be used when the submodel is set up.

D E F I N I T I O N S

General Extrusion 1 (genext1)
1 In the Model Builder window, expand the Full Model (comp1) node.

2 Right-click Full Model (comp1)>Definitions and choose Nonlocal Couplings>

General Extrusion.

3 In the Settings window for General Extrusion, locate the Source Selection section.

4 From the Selection list, choose All domains.

F U L L  M O D E L :  L O A D  H I S T O R Y

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Full Model: Load History in the Label text 
field.

Step 1: Time Dependent
1 In the Model Builder window, expand the Full Model: Load History node, then click 

Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Output times text field, type 0 0.005 range(0.025,0.025,0.5) range(0.75,
0.25,3.75) 3.975 4+{range(0,0.025,0.5) range(0.75,0.25,2)} 6+

{range(0.025,0.025,0.5) range(0.75,0.25,3.75) 3.975 4+{range(0,0.025,

0.5) range(0.75,0.25,2)}} 12+{range(0.025,0.025,0.5) range(0.75,0.25,

3.75) 3.975 4+{range(0,0.025,0.5) range(0.75,0.25,2)}} 18+

{range(0.025,0.025,0.5) range(0.75,0.25,3.75) 3.975 4+{range(0,0.025,

0.5) range(0.75,0.25,2)}}.

Solver Configurations
In the Model Builder window, expand the Full Model: Load History>Solver Configurations 
node.

Step 2: Time Dependent 2
In the Times text field, enter the same steps as Step 1.
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1 In the Model Builder window, expand the Full Model: Load History>Solver Configurations>

Solution 1 (sol1) node.

2 Right-click Full Model: Load History and choose Compute.

R E S U L T S

Stress (solid)
Perform a fatigue study on the full model in order to find out which solder joint is the 
critical one.

A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Structural Mechanics>Fatigue (ftg).

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Full Model: Load History.

5 Click Add to Full Model in the window toolbar.

6 In the Home toolbar, click Add Physics to close the Add Physics window.

F A T I G U E  ( F T G )

Energy-Based 1
1 Right-click Full Model (comp1)>Fatigue (ftg) and choose the domain evaluation Energy-

Based.

2 In the Settings window for Energy-Based, locate the Domain Selection section.

3 From the Selection list, choose Solder.

4 Locate the Solution Field section. From the Physics interface list, choose 
Solid Mechanics (solid).

5 Locate the Fatigue Model Selection section. From the Criterion list, choose Darveaux.

6 From the Energy type list, choose Viscoplastic dissipation density.

7 Locate the Fatigue Model Parameters section. In the a text field, type lcrack.

R O O T

In the Model Builder window, expand the Full Model (comp1)>Materials node.

G L O B A L  D E F I N I T I O N S

In the Model Builder window, expand the Global Definitions>Materials node.
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Solder, 60Sn-40Pb (mat4)
1 In the Model Builder window, click Solder, 60Sn-40Pb (mat4).

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

R O O T

From the Home menu, choose Add Study.

A D D  S T U D Y

1 Go to the Add Study window.

2 Find the Physics interfaces in study subsection. In the table, clear the Solve check boxes 
for Solid Mechanics (solid) and Heat Transfer in Solids (ht).

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces>Fatigue.

4 Click Add Study in the window toolbar.

5 From the Home menu, choose Add Study.

F U L L  M O D E L :  F A T I G U E  E V A L U A T I O N

1 In the Model Builder window, expand the Solder, 60Sn-40Pb (mat4) node, then click 
Study 2.

2 In the Settings window for Study, type Full Model: Fatigue Evaluation in the Label 
text field.

Step 1: Fatigue
1 In the Model Builder window, under Full Model: Fatigue Evaluation click Step 1: Fatigue.

Property Variable Value Unit Property 
group

Crack initiation energy coefficient K1_Darveau
x

13173 1 Darveaux

Crack initiation energy exponent k2_Darveau
x

-1.45 1 Darveaux

Crack propagation energy 
coefficient

K3_Darveau
x

3.92e-
7[in]

m Darveaux

Crack propagation energy 
exponent

k4_Darveau
x

1.12 1 Darveaux

Reference energy density Wref_Darve
aux

1[psi] J/m³ Darveaux
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2 In the Settings window for Fatigue, locate the Values of Dependent Variables section.

3 Find the Values of variables not solved for subsection. From the Settings list, choose 
User controlled.

4 From the Method list, choose Solution.

5 From the Study list, choose Full Model: Load History, Time Dependent 2.

6 From the Time (h) list, choose From list.

7 From the list, select time steps from 18h to 24h.

8 In the Home toolbar, click Compute.

R E S U L T S

Cycles to Failure (ftg)
The solder joint with the shortest life is the critical one. Create a submodel of that joint.

A D D  C O M P O N E N T

In the Model Builder window, right-click the root node and choose Add Component>3D.

S U B M O D E L

In the Settings window for Component, type Submodel in the Label text field.

G E O M E T R Y  2

Import 1 (imp1)
1 In the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
viscoplastic_solder_joints.mphbin.

5 Click Import.

Cylinder 1 (cyl1)
1 In the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 2.4e-4.

4 In the Height text field, type 9e-4.

5 Locate the Position section. In the x text field, type 68.28e-4.

6 In the y text field, type 55.38e-4.
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7 In the z text field, type 10e-4.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click the Select All button in the Graphics toolbar and remove the cylinder from the 
selection.

Intersection 1 (int1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Intersection.

2 Click in the Graphics window and then press Ctrl+A to select both objects.

Work Plane 1 (wp1)
1 In the Geometry toolbar, click Work Plane.

2 Click the Zoom Extents button in the Graphics toolbar.

3 In the Settings window for Work Plane, locate the Plane Definition section.

4 In the z-coordinate text field, type 13.5e-4.

5 Right-click Work Plane 1 (wp1) and choose Duplicate.

Work Plane 2 (wp2)
1 In the Model Builder window, click Work Plane 2 (wp2).

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type 15.5e-4.

Partition Objects 1 (par1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Partition Objects.

2 In the Settings window for Partition Objects, locate the Partition Objects section.

3 From the Partition with list, choose Work plane.

4 From the Work plane list, choose Work Plane 1 (wp1).

5 From the Repair tolerance list, choose Relative.

6 In the Relative repair tolerance text field, type 3E-4.

7 Select the object int1 only.

Partition Objects 2 (par2)
1 In the Geometry toolbar, click Booleans and Partitions and choose Partition Objects.

2 Select the object par1 only.

3 In the Settings window for Partition Objects, locate the Partition Objects section.

4 From the Partition with list, choose Work plane.
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5 Click Build All Objects.

6 Click the Zoom Extents button in the Graphics toolbar.

G E O M E T R Y  2

In the Model Builder window, collapse the Submodel (comp2)>Geometry 2 node.

A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Structural Mechanics>Thermal–Structure Interaction>Thermal Stress,

Solid.

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check boxes 
for Full Model: Load History and Full Model: Fatigue Evaluation.

5 Click Add to Submodel in the window toolbar.

6 In the Home toolbar, click Add Physics to close the Add Physics window.

S O L I D  M E C H A N I C S  2  ( S O L I D 2 )

1 In the Settings window for Solid Mechanics, locate the Structural Transient Behavior 
section.

2 From the list, choose Quasistatic.

Linear Elastic Material 1
1 Click the Show More Options button in the Model Builder toolbar.

2 In the Show More Options dialog box, in the tree, select the check box for the node 
Physics>Advanced Physics Options.

3 Click OK.

4 In the Model Builder window, under Submodel (comp2)>Solid Mechanics 2 (solid2) click 
Linear Elastic Material 1.

5 In the Settings window for Linear Elastic Material, click to expand the Energy Dissipation 
section.

6 Select the Calculate dissipated energy check box.

Viscoplasticity 1
1 In the Physics toolbar, click Attributes and choose Viscoplasticity.

2 In the Settings window for Viscoplasticity, locate the Domain Selection section.

3 Click Clear Selection.
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4 Select Domains 4–6 only.

Prescribe results of the structural analysis via displacements on the shared boundaries.

Prescribed Displacement 1
1 In the Physics toolbar, click Boundaries and choose Prescribed Displacement.

2 Select Boundaries 1–5, 8, 9, 11, and 22–27 only.

3 In the Settings window for Prescribed Displacement, locate the Prescribed Displacement 
section.

4 From the Displacement in x direction list, choose Prescribed.

5 In the u0x text field, type comp1.genext1(comp1.u).

6 From the Displacement in y direction list, choose Prescribed.

7 In the u0y text field, type comp1.genext1(comp1.v).

8 From the Displacement in z direction list, choose Prescribed.

9 In the u0z text field, type comp1.genext1(comp1.w).

10 Click to expand the Constraint Settings section. From the Apply reaction terms on list, 
choose Current physics (internally symmetric).

H E A T  T R A N S F E R  I N  S O L I D S  2  ( H T 2 )

In the Model Builder window, under Submodel (comp2) click Heat Transfer in Solids 2 (ht2).

Heat Source 1
1 In the Physics toolbar, click Domains and choose Heat Source.

2 Select Domain 3 only.

3 In the Settings window for Heat Source, locate the Heat Source section.

4 In the Q0 text field, type power(t).

Heat Flux 1
1 In the Physics toolbar, click Boundaries and choose Heat Flux.

2 Select Boundaries 7, 10, 12–15, 17, and 18 only.

3 In the Settings window for Heat Flux, locate the Heat Flux section.

4 From the Flux type list, choose Convective heat flux.

5 In the h text field, type 10.

6 In the Text text field, type T0.

Prescribe results of the heat transfer analysis via temperature on the shared boundaries.
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Temperature 1
1 In the Physics toolbar, click Boundaries and choose Temperature.

2 Select Boundaries 1–5, 8, 9, 11, and 22–27 only.

3 In the Settings window for Temperature, locate the Temperature section.

4 In the T0 text field, type comp1.genext1(comp1.T).

M A T E R I A L S

Material Link 5 (matlnk5)
1 In the Model Builder window, under Submodel (comp2) right-click Materials and choose 

More Materials>Material Link.

2 Select Domain 1 only.

Material Link 6 (matlnk6)
1 Right-click Materials and choose More Materials>Material Link.

2 Select Domain 2 only.

3 In the Settings window for Material Link, locate the Link Settings section.

4 From the Material list, choose Copper (mat2).

Material Link 7 (matlnk7)
1 Right-click Materials and choose More Materials>Material Link.

2 Select Domain 3 only.

3 In the Settings window for Material Link, locate the Link Settings section.

4 From the Material list, choose Silicon (mat3).

Material Link 8 (matlnk8)
1 Right-click Materials and choose More Materials>Material Link.

2 Select Domains 4–6 only.

3 In the Settings window for Material Link, locate the Link Settings section.

4 From the Material list, choose Solder, 60Sn-40Pb (mat4).

Refine the mesh in the solder ball.

M E S H  2

1 In the Model Builder window, under Submodel (comp2) click Mesh 2.

2 In the Settings window for Mesh, locate the Sequence Type section.

3 From the list, choose User-controlled mesh.
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Size 1
1 In the Model Builder window, right-click Free Tetrahedral 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 4–6 only.

5 Locate the Element Size section. From the Predefined list, choose Fine.

6 Click Build All.

Simulate the initial cycles using the submodel.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve check boxes 
for Solid Mechanics (solid), Heat Transfer in Solids (ht), and Fatigue (ftg).

4 Find the Studies subsection. In the Select Study tree, select General Studies>

Time Dependent.

5 Click Add Study in the window toolbar.

6 In the Model Builder window, click the root node.

7 In the Home toolbar, click Add Study to close the Add Study window.

S U B M O D E L :  L O A D  H I S T O R Y

In the Settings window for Study, type Submodel: Load History in the Label text field.

Step 1: Time Dependent
Store data mainly for the thermal cycle where we want to perform the fatigue evaluation.

1 In the Model Builder window, under Submodel: Load History click Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 From the Time unit list, choose h.

4 In the Output times text field, type 0 range(1,1,17) 18+{range(0,0.025,0.5) 
range(0.75,0.25,3.75) 3.95 4+{range(0.025,0.025,0.5) range(0.75,0.25,

2)}}.

5 Click to expand the Values of Dependent Variables section. Find the 
Values of variables not solved for subsection. From the Settings list, choose 
User controlled.
20 |  E N E R G Y - B A S E D  T H E R M A L  F A T I G U E  P R E D I C T I O N   I N  A  B A L L  G R I D  A R R A Y



6 From the Method list, choose Solution.

7 From the Study list, choose Full Model: Load History, Time Dependent 2.

8 From the Time (h) list, choose Automatic (all solutions).

Set up the solver in a similar way as in Study 1.

Solution 4 (sol4)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 4 (sol4) node.

3 In the Model Builder window, expand the Submodel: Load History>Solver Configurations>

Solution 4 (sol4)>Dependent Variables 1 node, then click 
Viscoplastic dissipation density (comp2.solid2.Wvp).

4 In the Settings window for Field, locate the Scaling section.

5 From the Method list, choose Manual.

6 In the Scale text field, type 1e5.

7 In the Model Builder window, under Submodel: Load History>Solver Configurations>

Solution 4 (sol4) click Time-Dependent Solver 1.

8 In the Settings window for Time-Dependent Solver, click to expand the Time Stepping 
section.

9 From the Steps taken by solver list, choose Strict.

10 Click to expand the Output section. Clear the Store time derivatives check box.

11 In the Model Builder window, expand the Submodel: Load History>Solver Configurations>

Solution 4 (sol4)>Time-Dependent Solver 1 node, then click Segregated 1.

12 In the Settings window for Segregated, locate the General section.

13 From the Termination technique list, choose Iterations.

14 In the Model Builder window, expand the Submodel: Load History>Solver Configurations>

Solution 4 (sol4)>Time-Dependent Solver 1>Segregated 1 node, then click Temperature.

15 In the Settings window for Segregated Step, click to expand the Method and Termination 
section.

16 From the Termination technique list, choose Tolerance.

17 In the Tolerance factor text field, type 1.

18 In the Model Builder window, under Submodel: Load History>Solver Configurations>

Solution 4 (sol4)>Time-Dependent Solver 1>Segregated 1 click Solid Mechanics 2.

19 In the Settings window for Segregated Step, locate the Method and Termination section.
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20 From the Nonlinear method list, choose Constant (Newton).

21 From the Termination technique list, choose Tolerance.

22 In the Maximum number of iterations text field, type 20.

23 Locate the General section. In the Variables list, select 
Viscoplastic dissipation density (comp2.solid2.Wvp).

24 Under Variables, click Delete.

25 In the Model Builder window, under Submodel: Load History>Solver Configurations>

Solution 4 (sol4)>Time-Dependent Solver 1 right-click Segregated 1 and choose 
Segregated Step.

26 Drag and drop Submodel: Load History>Solver Configurations>Solution 4 (sol4)>Time-

Dependent Solver 1>Segregated 1>Segregated Step 3 below Solid Mechanics 2.

27 In the Settings window for Segregated Step, locate the General section.

28 Under Variables, click Add.

29 In the Add dialog box, select Viscoplastic dissipation density (comp2.solid2.Wvp) in the 
Variables list.

30 Click OK.

31 In the Settings window for Segregated Step, type Energy Dissipation in the Label text 
field.

32 Locate the Method and Termination section. From the Termination technique list, choose 
Tolerance.

33 In the Tolerance factor text field, type 1.

34 In the Study toolbar, click Compute.

R E S U L T S

Stress (solid2)
Simulate the fatigue load cycle on the submodel and evaluate fatigue response of the 
critical solder joint.

S U B M O D E L  ( C O M P 2 )

In the Model Builder window, click Submodel (comp2).

A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.
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3 In the tree, select Structural Mechanics>Fatigue (ftg).

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check boxes 
for Full Model: Load History, Full Model: Fatigue Evaluation, and Submodel: Load History.

5 Click Add to Submodel in the window toolbar.

6 In the Home toolbar, click Add Physics to close the Add Physics window.

F A T I G U E  2  ( F T G 2 )

Energy-Based 1
1 Right-click Submodel (comp2)>Fatigue 2 (ftg2) and choose the domain evaluation 

Energy-Based.

2 Select Domains 4–6 only.

3 In the Settings window for Energy-Based, locate the Solution Field section.

4 From the Physics interface list, choose Solid Mechanics 2 (solid2).

5 Locate the Fatigue Model Selection section. From the Criterion list, choose Darveaux.

6 From the Energy type list, choose Viscoplastic dissipation density.

7 Locate the Evaluation Settings section. From the Volume average method list, choose 
Entire selection.

8 Locate the Fatigue Model Parameters section. In the a text field, type lcrack.

A D D  P H Y S I C S

1 In the Physics toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Recently Used>Fatigue (ftg).

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check boxes 
for Full Model: Load History, Full Model: Fatigue Evaluation, and Submodel: Load History.

5 Click Add to Submodel in the window toolbar.

6 In the Physics toolbar, click Add Physics to close the Add Physics window.

F A T I G U E  3  ( F T G 3 )

Right-click Submodel (comp2)>Fatigue 3 (ftg3) and choose the domain evaluation Energy-

Based.

1 Select Domains 4–6 only.

2 In the Settings window for Energy-Based, locate the Solution Field section.

3 From the Physics interface list, choose Solid Mechanics 2 (solid2).
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4 Locate the Fatigue Model Selection section. From the Criterion list, choose Darveaux.

5 From the Energy type list, choose Viscoplastic dissipation density.

6 Locate the Fatigue Model Parameters section. In the a text field, type lcrack.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve check boxes 
for Solid Mechanics (solid), Heat Transfer in Solids (ht), Fatigue (ftg), 
Solid Mechanics 2 (solid2), and Heat Transfer in Solids 2 (ht2).

4 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces>Fatigue.

5 Click Add Study in the window toolbar.

6 In the Home toolbar, click Add Study to close the Add Study window.

S U B M O D E L :  F A T I G U E  E V A L U A T I O N

1 In the Model Builder window, click Study 4.

2 In the Settings window for Study, type Submodel: Fatigue Evaluation in the Label 
text field.

Step 1: Fatigue
1 In the Model Builder window, under Submodel: Fatigue Evaluation click Step 1: Fatigue.

2 In the Settings window for Fatigue, locate the Values of Dependent Variables section.

3 Find the Values of variables not solved for subsection. From the Settings list, choose 
User controlled.

4 From the Method list, choose Solution.

5 From the Study list, choose Submodel: Load History, Time Dependent.

6 From the Time (h) list, choose From list.

7 From the list, select time steps from 18h to 24h.

8 In the Home toolbar, click Compute.

R E S U L T S

Temperature (ht2)
Compare the viscoplastic dissipation in the full model and in the submodel.
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Dissipation History
1 In the Model Builder window, click Dissipation History.

2 In the Settings window for 1D Plot Group, click to expand the Title section.

3 From the Title type list, choose None.

4 Locate the Legend section. From the Position list, choose Upper left.

Point Graph 1
1 In the Model Builder window, expand the Dissipation History node, then click 

Point Graph 1.

2 In the Settings window for Point Graph, click to expand the Legends section.

3 Select the Show legends check box.

4 From the Legends list, choose Manual.

5 In the table, enter the following settings:

6 Right-click Point Graph 1 and choose Duplicate.

Point Graph 2
1 In the Model Builder window, click Point Graph 2.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type solid2.WvpGp.

4 In the Unit field, type kJ/m^3.

5 Locate the Data section. From the Dataset list, choose Submodel: Load History/

Solution 4 (5) (sol4).

6 Locate the Selection section. Click to select the Activate Selection toggle button.

7 Select Point 9 only.

8 Click to expand the Coloring and Style section. Find the Line markers subsection. From 
the Marker list, choose Circle.

9 Locate the Legends section. In the table, enter the following settings:

Dissipation History
In the Model Builder window, right-click Dissipation History and choose Duplicate.

Legends

Full model

Legends

Submodel
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Shear Viscoplasticity History
1 In the Model Builder window, under Results click Dissipation History 1.

2 In the Settings window for 1D Plot Group, type Shear Viscoplasticity History in 
the Label text field.

3 Locate the Plot Settings section.

4 Select the y-axis label check box. In the associated text field, type Shear 
viscoplasticity.

5 Locate the Legend section. From the Position list, choose Lower left.

Point Graph 1
1 In the Model Builder window, expand the Shear Viscoplasticity History node, then click 

Point Graph 1.

2 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-Axis Data section. From the menu, choose Full Model (comp1)>

Solid Mechanics>Strain>Viscoplastic strain tensor, local coordinate system>

solid.evplGp13 - Viscoplastic strain tensor, local coordinate system, 13-component.

Point Graph 2
1 In the Model Builder window, click Point Graph 2.

2 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-Axis Data section. From the menu, choose Submodel (comp2)>

Solid Mechanics 2>Strain>Viscoplastic strain tensor, local coordinate system>

solid2.evplGp13 - Viscoplastic strain tensor, local coordinate system, 13-component.

3 In the Shear Viscoplasticity History toolbar, click Plot.

Verify that the temperature is the same in both studies.

Temperature History
1 In the Model Builder window, under Results click Temperature History.

2 In the Settings window for 1D Plot Group, locate the Title section.

3 From the Title type list, choose None.

4 Locate the Plot Settings section.

5 Select the y-axis label check box. In the associated text field, type Temperature (C).

6 Locate the Legend section. From the Position list, choose Upper left.

Point Graph 1
1 In the Model Builder window, expand the Temperature History node, then click 

Point Graph 1.
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2 In the Settings window for Point Graph, locate the Legends section.

3 Select the Show legends check box.

4 From the Legends list, choose Manual.

5 In the table, enter the following settings:

6 Right-click Point Graph 1 and choose Duplicate.

Point Graph 2
1 In the Model Builder window, click Point Graph 2.

2 In the Settings window for Point Graph, locate the y-Axis Data section.

3 In the Expression text field, type T2.

4 In the Unit field, type degC.

5 Locate the Data section. From the Dataset list, choose Submodel: Load History/

Solution 4 (5) (sol4).

6 Locate the Selection section. Click to select the Activate Selection toggle button.

7 Select Point 9 only.

8 Locate the Coloring and Style section. Find the Line style subsection. From the Line list, 
choose None.

9 Find the Line markers subsection. From the Marker list, choose Circle.

10 Locate the Legends section. In the table, enter the following settings:

Display the minimum cycles to failure for each solution.

Cycles to Failure (ftg)
In the Model Builder window, expand the Cycles to Failure (ftg) node.

Marker 1
1 In the Model Builder window, expand the Results>Cycles to Failure (ftg)>Surface 1 node, 

then click Marker 1.

2 In the Settings window for Marker, locate the Text Format section.

3 In the Display precision text field, type 2.

Legends

Full model

Legends

Submodel
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Temperature (ht2)
In the Model Builder window, expand the Temperature (ht2) node.

Cycles to Failure (ftg3)
1 In the Model Builder window, expand the Results>Temperature (ht2)>Volume 1 node.

2 In the Model Builder window, expand the Cycles to Failure (ftg3) node.

Marker 1
1 In the Model Builder window, expand the Results>Cycles to Failure (ftg3)>Surface 1 node, 

then click Marker 1.

2 In the Settings window for Marker, locate the Text Format section.

3 In the Display precision text field, type 1.

Evaluation Group 1
In the Results toolbar, click Evaluation Group.

Volume Minimum 1
1 Right-click Evaluation Group 1 and choose Volume Minimum.

2 In the Settings window for Volume Minimum, locate the Data section.

3 From the Dataset list, choose Full Model: Fatigue Evaluation/Solution 3 (sol3).

4 Locate the Selection section. From the Selection list, choose Solder.

5 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Full Model (comp1)>Fatigue>ftg.ctf - Cycles to failure - 1.

Evaluation Group 1
In the Model Builder window, click Evaluation Group 1.

Volume Minimum 2
1 In the Evaluation Group 1 toolbar, click Minimum and choose Volume Minimum.

2 In the Settings window for Volume Minimum, locate the Data section.

3 From the Dataset list, choose Submodel: Fatigue Evaluation/Solution 5 (7) (sol5).

4 Select Domains 4–6 only.

5 Locate the Expressions section. In the table, enter the following settings:

6 In the Evaluation Group 1 toolbar, click Evaluate.

Expression Unit Description

ftg2.ctf 1 Cycles to failure, submodel

ftg3.ctf 1 Cycles to failure, thin layer in submodel
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